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■ ASPI—uses an optional I/O programming interface that is available 
on all versions of Windows. This I/O mode can be used with any 
Windows operating system. It may require the installation or update 
of additional OS components, possibly requiring a reboot of the 
system during installation.

For information about other functionality of the splash screen, refer to 
the user guide or online help.

 Application Window Layout
After the I/O mode is selected, click Continue on the splash screen. The 
L&TT main screen is displayed. Figure 1 shows the L&TT main screen 
divided into three sections.

Figure 1:  L&TT main screen

The three sections of the L&TT main screen are:

1. Taskbar contains buttons that provide quick access to the main 
functions of L&TT and to the online help system.

Note:  Above the Taskbar is the standard Windows menu bar that 
provides alternate navigation to tool functions, as well as access to a 
number of other features.

2. Device List is a multi-function window that offers several options 
on the following tabs:

■ Scan provides either a summary status or detailed information 
(depending on whether Show Details or Hide Details is 
selected) about the bus scanning process. If a problem is 
encountered during the scan, this information may help in 
determining the cause. When the scan completes successfully, 
the device list automatically switches to the By Product tab.

The Scan tab also lets you rescan the bus. If any devices have 
been hot-swapped or powered on after the OS has booted, in 
most cases, the rescan feature can discover those devices 
without requiring a reboot of the system.

Caution:  Swapping SCSI devices, including connecting and 
disconnecting cables and/or terminators, can cause the system to 
hang or crash.

Caution:  On Windows NT 4.0, 2000, XP, and .NET, changing 
devices at a specific SCSI address can cause unpredictable 
behavior. Parts of the operating system may not detect that the 
device or device type has changed.

■ By Product shows a list of all the products connected to the 
system. The list is grouped into the following four categories:

— Libraries and autoloaders

— Drives

— Enclosures and processors

— Other devices 
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About This Guide
This Getting Started Guide is intended as an overview of installation and 
basic usage for HP StorageWorks Library and Tape Tools (L&TT). For 
detailed information on any procedure, refer to the user guide or online 
help.

The Microsoft® Windows® version of L&TT uses a graphical user 
interface ( ), whereas the NetWare, HP-UX, Tru64, and Linux 
versions of the program use a command screen interface ( ). Click 
the appropriate bookmark in the left panel to display the section of this 
guide that corresponds to your operating environment.

Supported Products and Operating Systems
For a complete listing of compatible products, refer to the HP Library 
and Tape Tools Compatibility Matrix found at:

http://www.hp.com/support/lttcompatibility

Finding Additional Information
The HP website provides the current version of L&TT for download, and 
general information about the tool. Access the website at:

http://www.hp.com/support/tapetools
You can quickly access this website by clicking the L&TT Support link 
in the navigation bar from any page in this Getting Started Guide.

Getting Support
E-mail support is available from ltt_team@hp.com. You should expect a 
response within 48 hours (usually sooner) during a normal business 
week.

Use this address to obtain support for L&TT, to report bugs, to provide 
feedback on this manual, to report any issues with the L&TT website, or 
to provide enhancement suggestions. HP appreciates feedback on how to 
make improvements for future versions of L&TT.

Note:  This address is intended to provide support for L&TT software. This 
address is NOT for assistance in troubleshooting hardware products. Refer to 
the documentation that comes with your hardware for support options for that 
product.

 Installing L&TT for Windows
The Windows version of L&TT uses the InstallShield application. 
InstallShield lets you choose the installation directory and select other 
options. It also sets up shortcuts to launch the application in the Start 
menu and on the desktop. The Start menu shortcuts also provide access 
to the online help, the readme file, the report viewer, and the uninstaller.

Upgrading from a Previous Version of L&TT
HP strongly recommends uninstalling any previous versions of L&TT 
before installing the most recent version. To uninstall L&TT, use the 
Add/Remove Programs applet in the Windows control panel. If you are 
presented with an option to completely remove the installation folder, 
reply No to keep the existing folder structure in place. This will preserve 
all of your previous L&TT files such as log files, SCSI scripts, and so 
forth.

Installation Procedure
To install the current Windows version of L&TT:

1. Download or copy the self-extracting executable file to a temporary 
location.

2. Double-click the self-extracting executable file to launch the 
installer. The InstallShield Wizard screen is displayed.

3. Click Next. Read the program license agreement and click Yes if 
you agree to and accept the terms of the license agreement.

4. Read the readme file for any last-
documentation, then click Next. 
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 Starting L&TT
To start L&TT:

■ Double-click the L&TT icon on 
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■ Click Start  > Programs > HP S
Tools > HP StorageWorks Libr

 Using the Splash
When L&TT is started, the splash scre
you the opportunity to exit the applica
has taken place. This feature lets you e
unintentionally. This prevents the prog
backup or other storage applications t

The splash screen also allows you to s
than one option is available). 

I/O Mode
L&TT selects the input/output (I/O) m
the system it is running on. However, 
manual selection of the I/O mode in c
operates in the following two I/O mod

■ NT Miniport—uses an interface
2000, XP, and Windows Server 2
mode on systems where it is avai
the installation of the ASPI interf
limitations to the Windows NT M
devices that are “claimed” by oth
with non-standard OS drivers. In
O mode can make a device acces

Note:  The Windows NT Miniport I/O m

http://www.hp.com/support/lttcompatibility
http://www.hp.com/support/tapetools


ket, you must either have a MAPI-
icrosoft Outlook or Outlook 
l account using the Windows 
r more information about setting 
 guide or online help.

x is divided into three steps:

s a new support request or an 

est, select the Send to support 
t by e-mail option (this option is 
ct number and product serial 
elds.

 case, select the Send to support 
 open case option and enter the 

e appropriate field.

-mail address. Use the dropdown 
port providers, or enter the e-mail 

dditional information:

er your company name, contact 
ntact e-mail address.

 this option to attach the support 
sis by HP service personnel.

og (only if requested)—Select 
requested by HP service personnel 
ore information about using the 
uide or online help.

et—Select this option to compress 
on is selected by default.

er a detailed description of the 

lick Send.

ement
lity of L&TT provides a 
firmware of connected devices. 
es within the libraries can be 
iple drives within the library can 
e.

 associate the firmware with a 
ts the user from downloading the 
nloaded firmware is the same or a 
 firmware.

agement Screen
t screen, click the device you want 
the Firmware button on the main 

 Firmware directory. This 
Library & Tape Tools 
g any firmware, you must acquire 
py them to the Firmware 
ed in three ways:

ting and click the Firmware 
e Firmware screen, click the 
e Get Files from Web button at 
oaded files are automatically 
ry.

 Get Files From Web from the 
 the L&TT firmware ftp site and 
opy to your system. Downloaded 
he Firmware directory. This 
e following section.

se the product family, then click 
he latest firmware file is available 
cts (such as standalone drives), 

firmware is available as a single file. For other products (such as 
tape libraries), the firmware is available in a self-extracting bundle 
that includes library and drive firmware.

Note:  Do not use the Get Firmware From Web functionality within L&TT 
without an Internet connection. Doing so can cause the system to lock up until it 
has timed out in the operating system. This timeout value is operating system-
specific.

Note:  If Check for Updates on Web is enabled in the tool preferences, L&TT 
automatically informs the user when new firmware is available for any of the 
connected storage products. L&TT performs this check each time it is started 
(but not more than once per 24-hour period).

Using the Get Files from Web Functionality
The Windows version of L&TT offers comprehensive firmware 
management functionality that finds and downloads firmware from the 
HP website. This functionality obtains the most up-to-date information 
about all available firmware files directly from the HP website. It then 
compares this data set to the list of devices connected to the system and 
the current firmware revisions present in those devices. Depending on 
the selected filter options on the top of the screen, different subsets of 
firmware files are presented. Firmware files that are needed to bring the 
connected devices up to the latest firmware revisions are automatically 
selected.

Note:  L&TT scripts are also obtained using the Get Files from Web dialog box. 
For more information on scripts, refer to the user guide or online help.

Accessing the Get Files from Web Dialog Box
You can access the Get Files from Web dialog box in two ways:

■ Select Get Files from Web from the File menu

- or -

■ Click the Get Firmware button on the Firmware Update screen

The Get Files from Web dialog box is displayed. Click the Firmware 
(New Files Available) tab if it is not already selected. 

Selecting and Downloading Updated Firmware Files
The Get Files from Web dialog box has four filter options:

■ For devices on this system—These two options only show 
firmware files matching devices that are currently connected to the 
system.

— Show latest firmware only shows the most recent firmware 
revision for each device.

— Show all firmware shows all firmware revisions for each of 
these firmware files.

■ For all supported devices—These two options show firmware files 
for all devices supported by LTT, even if not currently connected to 
the system.

— Show latest firmware only shows the most recent firmware 
revision for each device.

— Show all firmware shows all firmware revisions for each of 
these firmware files.

Select the appropriate option, and then verify that the correct firmware 
files are selected. To download the selected files, click Download. The 
files are automatically downloaded to the current firmware directory on 
the local system. You can now use the firmware update functionality of 
L&TT to upload the latest firmware to your devices.

Uploading Firmware to Devices
Before attempting to update any firmware files, you must first acquire 
the latest firmware files and ensure that they are placed in the 
Firmware directory. If you have not yet done this, see Acquiring 
Firmware Files.

To upload firmware to a device:

1. Click the device you want to update in the device list.

2. Click the Firmware button on the main toolbar.
The three number fields listed after the device represent the 
device address. Each field in the address is separated by a 
period: the first field represents the HBA channel, the second 
field represents the SCSI ID, and the third field represents the 
LUN. 

Note:  When using the Miniport I/O mode, the HBA channel field is 
shown as “A/B,” where A is the channel and B is the subchannel.

■ By Connection shows all products connected to the system, 
grouped by the HBA they are connected to. This view makes it 
easy to see which devices are connected to the same bus as the 
device in question, and may help in understanding system I/O 
performance issues.

■ Instructions contains brief instructions on how to use the 
selected screen. This view can be disabled in the software 
preferences. 

3. Device Information screen—All the main functions of the 
program are displayed in this window. The content of this window 
depends on the device and tool function selected.

 Using the Device Information Screen
When you select a product from the device list, the Device Information 
screen displays information relevant to the device. The device list also 
changes to display instructions on this page (if the instructions 
preference is enabled). If another tool function is currently active, then 
clicking the Identity button on the toolbar opens the Device 
Information screen. The Device Information screen provides an 
overview of the selected hardware device and its current configuration 
and status.

When a standalone device is selected in the Device List, the Device 
Information screen contains a single tab labeled Drive Information. 
When a library or autoloader is selected in the device list, the Device 
Information screen displays two tabs: one for library information and 
one for the drives contained within the library.

To see information for the drives within the library, select the Drive 
Information tab. This tab displays a screen very similar to the one for 
standalone products, with the addition of the Selected Drive dropdown 
menu.

Because a library can contain multiple drives, you can select and view 
information for each drive using the Selected Drive dropdown menu. All 
of the drives in the library are available in the dropdown menu. 

Note:  Selecting individual drives within a library from the By Product/By 
Connection device list displays the drive as though it were a standalone 
product. The recommended method of diagnosing embedded drives is to first 
select the library they belong to, and then select the specific drive within each 
tool window.

 Support Ticket Generation
A major feature of HP StorageWorks Library and Tape Tools is the 
ability to generate a support ticket. In the event of a hardware problem, a 
support ticket can provide vital information to help in diagnosing and 
resolving the problem.

Accessing the Support Screen
To open the Support screen:

1. Click a device in the device list (By Product or By Connection 
tab) to select it.

2. Click the Support button on the main toolbar to display the 
Support screen.

Generating a Support Ticket
The Support screen presents three options for generating a support 
ticket. Each of the following three options has a corresponding button in 
the Generate Support Ticket section of the screen.

■ View Support Ticket—Click this button to generate the support 
ticket and immediately view it in the support ticket viewer. The 
support ticket can later be saved or sent via e-mail. For more 
information, see Viewing a Support Ticket.

■ Save Support Ticket to File—Click this button to generate and 
save the support ticket. The support ticket is saved as a log file with 
the *.ltt extension. Large support tickets are broken up into multiple 
log files. The support ticket can later be viewed or sent via e-mail. 
To view a saved support ticket, open it through Windows Explorer, 
or use the Load command on the File menu.

■ Send Support Ticket by E-mail—Click this button to generate the 
support ticket and immediately send it via e-mail to an HP support 
center (or other destination). Clicking this button opens a form for 
you to provide all the necessary information. Complete the form 
and click the Send button to send the e-mail. Using this option does 
not save a copy of the support ticket locally, so you are advised to 
click Save Support Ticket to File to save a copy for your own 
reference. For more information, see Sending a Support Ticket by 
E-mail.

Viewing a Support Ticket
After a support ticket is generated, it is displayed in the support ticket 
viewer. This viewer is built into the L&TT program. Information is 
displayed in a standard tree-view format. Click the “+” and “–” signs to 
expand and collapse sections of the support ticket. Use the standard 
navigation keys (Home, End, Page Up, Page Down, and the arrow 
keys), the Windows scroll bars, and the mouse to navigate through the 
document.

To print the support ticket, select File > Print from the menu bar within 
the support ticket viewer.

Using the Tabular View

Items in the support ticket that are preceded with the Tabular View icon
(  ) have additional information that can be displayed in Tabular 
View. To view the additional information in Tabular View, click the icon. 
One of the following occurs:

■ If only one view is available for the item you clicked, then a Tabular 
View window immediately opens.

■ If more than one view is available for the item you clicked, a 
shortcut menu is displayed. Select the desired option and click OK. 
The Tabular View window opens.

The Tabular View window supports the following operations:

■ Sorting columns—Click a column header to sort by that column. 
Repeatedly clicking the same column header toggles between 
ascending and descending sort order.

■ Filtering columns—Right-click a column header and choose 
Filter from the context menu to filter a column. A dialog box 
prompts you for the filter value. Enter a value and click Filter. To 
remove the filter, right-click the column header again and choose 
Clear Filter from the context menu.

■ Exporting data—The Tabular View data can be exported as a CSV 
(comma separated value) file. Choose Export from the File menu. 
Enter the path and filename for the CSV file in the dialog box and 
click Save.

Setting the Detail Level

The support ticket can display information in several different levels of 
detail, depending on the setting displayed in the Current Detail Level 
dropdown box. The following detail level settings are available:

■ Highlights only

■ Normal

■ More detail

■ Everything (the highest level the end user can view)

■ Factory only (requires a factory password)

For more information about items reported on a support ticket, refer to 
the user guide or online help.

Sending a Support Ticket by E-mail
From the Support screen, click Send Support Ticket by E-mail to 
generate the support ticket and immediately send it via e-mail to an HP 
support center (or other destination). When you click Send Support 
Ticket by E-mail, the E-mail Support Ticket dialog box is displayed.
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Note:  The gauges in the Disc Capacity section of the screen show the amount 
of disk space required for the System Performance test using the current 
settings, and the amount of space available in the indicated filesystem. If the 
required space exceeds the available space, the Test Size gauge displays 
OVERFLOW, and you will be unable to start the test.

4. Click Start to perform the test. Progress of the test is displayed in 
the status bar to the right of the Start button, and a dialog box will 
inform you when the test is complete.

5. Click the System Performance Results tab to view the test results. 
The test results are also written to the event log.

Performing the System Performance Backup Pre-Test
This test reads the sample data files that were written in the System 
Performance Restore Pre-Test. You must perform the Restore Pre-Test 
before performing the Backup Pre-Test. If you have not yet performed 
the Restore Pre-Test, see Performing the System Performance Restore 
Pre-Test (GUI).

1. Click Sys Perf on the main toolbar. The System Performance 
screen is displayed.

2. Click the Backup Pre-Test tab.

Figure 4:  Backup Pre-Test tab of the System Performance screen

3. Specify the following parameters:

■ Read Size—enter the maximum block size (in bytes) to 
transfer.

■ Directory Traverse Method—specify one of the following 
options:

— Specify Depth to have the test read as far down the 
directory structure as possible before moving laterally to 
the next directory.

— Specify Breadth to read all directories at the same level 
before moving down to the next subdirectory level.

■ Stop After—specify a time limit for the test, or select “All 
Readers Complete” to continue testing until the test is 
complete.

■ Reader [1-4]—enter up to four target directories (use the 
Browse>>> button to browse to each directory) that the test 
will read data from. For each Reader, you must have first 
performed a Restore Pre-Test. Use the same directory or 
directories that you specified in the Restore Pre-Test(s).

■ Read Files—specify whether the files must be read back from 
the tape after the write completes.

4. Click Start to perform the test. A dialog box will inform you when 
the test is complete.

5. Click the System Performance Results tab to view the test results. 
The test results are also written to the event log.
3. On the Update Firmware tab, click the checkbox next to the 
device name to select it. If firmware is currently available for that 
device, it is shown in the Firmware File dropdown box in the File 
Selection section of the screen.

Note:  You can select multiple devices and update them simultaneously.
4. Click the Start Update button at the bottom of the screen to begin 

the update.

Caution:  Make sure that no other programs attempt to access the 
device during the firmware update. Do not interrupt the firmware 
update. If the firmware update is interrupted, the device may not 
operate and require physical repair.

L&TT creates a log of all firmware update activity. To view this log, 
click the Firmware Update Results tab. Set the Current Detail Level 
setting to the appropriate level. The default is Normal. The firmware log 
is displayed in a standard tree-view format. If you want to clear the log, 
click the Clear Log button.

 Tests
L&TT provides numerous tests for analyzing storage hardware. These 
tests are grouped into two categories: diagnostic tests and performance 
tests. Several of the diagnostic tests are SCSI script-based. A SCSI script 
is a sequence of SCSI commands sent to a device, usually for the 
purpose of testing the device’s functionality. SCSI scripts can also be 
used to perform non-diagnostic utility functions, such as rewinding a 
tape, recalibrating a tape head, or “exercising” a tape-moving robot arm. 
A main advantage of SCSI script-based tests is that they can be updated 
with new functionality and new tests can be added. For more information 
about available tests, refer to the user guide or online help.

Note:  L&TT scripts are obtained using the Get Files from Web dialog box. For 
more information on scripts, refer to the user guide or online help.

Running the Diagnostic Tests
To select and run a test manually:

1. In the device listing (either the By Product or By Connection tab), 
click the device.

2. Click Test on the main toolbar. The Tests screen is displayed and 
the Test Execution tab is selected by default.

3. Click the checkbox to the left of the device name that you want to 
test. The Test Group dropdown box is enabled, listing all the tests 
available for the selected device.

4. In the Test Group dropdown box, select the test that you want to 
perform. A description of the selected test is displayed in the 
Description text box.

5. If any options are available for the test you selected, the Options 
button is enabled. Click the Options button to review and set the 
desired options.

6. Click the Start Test button to start the test.

Viewing Diagnostic Test Results
After the test has completed, click the Test Results tab to view the 
results. The results of the test are displayed in the Test text box. A more 
detailed Test Operation Log is displayed in the bottom section of the 
screen. The information is presented as a report in a standard tree-view 
format. Click  “+” or “–”  to expand or collapse a section of the report. 
Select an option in the Current Detail Level dropdown box to display 
more or less information in the Test Operation Log.

Using the Drive Performance Test
The Drive Performance test writes and reads data to/from the specified 
tape drive and calculates performance data for that drive. The results of 
the test are shown on the Drive Performance Results tab and also 
written to the event log.

To start the Drive Performance test:

Caution:  This test is destructive to data on the tape. To avoid loss of 
data, use a blank tape when performing this test.

1. In the device listing (either the By Product or By Connection tab), 
click the drive to test.

2. Click Dev Perf on the main toolbar. The Drive Performance 
screen is displayed and the Tape Drive Performance tab is selected 
by default.

Figure 2:  Drive Performance screen

3. In the Test Logic section of the screen, use the drop down boxes to 
select a data type for each of the four tests. The Drive Performance 
test is actually a series of four write/read subtests (labeled Step 1-4 
on the Drive Performance screen) that measure performance using 
different types of data that you can specify.

The following data types can be selected:

■ Zeros

■ 1.6:1 Compression

■ 2:1 Compression

■ 3:1 Compression

■ 4:1 Compression

You must specify a data type for Step 1, but you can choose not to 
perform Steps 2 through 4 by selecting No Test in the 
corresponding dropdown box.

4. Specify the following additional parameters:

■ Block Mode—choose one of the following:

— Fixed uses a fixed block size (length) that can be 
specified in the Block Size dropdown box.

— Variable uses a different mode of data transfer. When 
this option is selected, the Block Size dropdown box is 
disabled.

■ Block Size—if Block Mode is set to Fixed, specify the size of 
the data blocks used in the test. Data blocks can be from 16K 
to 256K. This dropdown box is disabled if Block Mode is set 
to Variable.

■ I/O Size—specify the maximum amount of data to be 
transferred by a single read/write operation. This length is 
typically a multiple of the Block Size and ranges from the 
specified Block Size to 1MB.

■ Test Size—specify the maximum amount of data written/read 
by the test. Valid choices range from 1GB to 15GB. Larger 
values increase the time required to perform the test, but they 
produce more accurate test results.

■ File Mark Mode—indicate whether the test should write a 
filemark at the specified interval (1MB to 1GB). You can also 
instruct the test not to write any filemarks.

■ Read After Write—when e
and then the tape is read bac
performance is measured. T
metrics when enabled, and o

■ Rate Limiting—if rate limi
limited to the specified valu

5. Click Start to perform the test. P
the status bar to the right of the S
informs you when the test is com

6. Click the Drive Performance Re
test. The results are also written t

Using the System Performanc
The System Performance test w
the specified directory and calc
the backup server. The Restore 
Pre-Test (read) portions of the t
tests and are executed separatel

Performing the System Performa
1. Click Sys Perf on the main toolb

screen is displayed.

2. Click the Restore Pre-Test tab.

Figure 3:  Restore Pre-Test tab of th

3. Specify the following parameters

■ Test Path—enter the destin
Browse>>> button to brows
write data to. This should be
being tested.

■ Test Data Type—select the
Choose from the following 

— Fixed Byte

— Incrementing

— Random

— Uncompressable Data

— 2:1 Compression Ratio

— 3:1 Compression Ratio

— 4:1 Compression Ratio

■ File Size—use the two drop
possible file sizes for the tes

■ File Tree Depth—specify t
subdirectories the program w
directory.

■ File Tree Breadth—specify
created within each subdirec

■ Files Per Directory—speci
within each subdirectory.
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Figure 2:  Command Help screen accessed from the Main screen

It is possible to enter a command directly from the Command Help 
screen. To do this, type either the number of the command or the name of 
the command and press Enter. Entering the number of the command 
only works on the Command Help screen. From any other screen, you 
must type the full name of the command. To exit the Command Help 
screen, enter a blank command (press Enter).

Some commands require an argument. For example, the select 
command requires a number that corresponds to the device you want to 
select in the device list. To select the first device in the list, the syntax is:

select 1

If you enter a command with an invalid or missing argument, an error 
message is displayed.

 Using the Device Information Screen
When you first select a product from the Main screen, the Device 
Information screen opens, showing information relevant to the device. 

The main purpose of the Device Information screen is to provide an 
overview of the configuration and status of the selected hardware device.

From the Main screen, type the following command to access the 
Device Information screen:

select <n> (where <n> is the number of the device you want to 
examine)

Note:  Alternatively, you can omit the select command and only enter the 
device number.

Standalone Devices
Figure 3 shows the Device Information screen for a standalone device.

Figure 3:  Device Information screen for a standalone device

The following general information is displayed:

■ Product ID (inquiry string)

■ Drive technology

■ Mech. serial # (drive serial number)

■ Firmware revision

■ SCSI target ID

■ SCSI LUN
hp StorageWorks
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Getting Started Guide

About This Guide
This Getting Started Guide is intended as an overview of installation and 
basic usage for HP StorageWorks Library and Tape Tools (L&TT). For 
detailed information on any procedure, refer to the user guide or online 
help.

The Microsoft Windows version of L&TT uses a graphical user interface 
( ), whereas the NetWare, HP-UX, Tru64, and Linux versions of the 
program use a command screen interface ( ). Click the appropriate 
bookmark in the left panel to display the section of this guide that 
corresponds to your operating environment.

Supported Products and Operating Systems
For a complete listing of compatible products, refer to the HP Library 
and Tape Tools Compatibility Matrix found at:

http://www.hp.com/support/lttcompatibility

Finding Additional Information
The HP website provides the current version of L&TT for download, and 
general information about the tool. Access the website at:

http://www.hp.com/support/tapetools
You can quickly access this website by clicking the L&TT Support link 
in the navigation bar from any page in this Getting Started Guide.

Getting Support
E-mail support is available from ltt_team@hp.com. You should expect a 
response within 48 hours (usually sooner) during a normal business 
week.

Use this address to obtain support for L&TT, to report bugs, to provide 
feedback on this manual, to report any issues with the L&TT website, or 
to provide enhancement suggestions. HP appreciates feedback on how to 
make improvements for future versions of L&TT.

Note:  This address is intended to provide support for L&TT software. This 
address is NOT for assistance in troubleshooting hardware products. Refer to 
the documentation that comes with your hardware for support options for that 
product.

 Installing L&TT for NetWare
To install the NetWare version of L&TT:

1. Download the L&TT for NetWare file to a temporary directory.

2. From a client workstation, use any standard unzip utility* to extract 
the file to the SYS:System\ directory on the NetWare server. 
Make sure that the option to create a directory is enabled in the 
archiving software.

Note:  * The unzip NLM that comes with later versions of NetWare has not 
been tested and should not be used to unzip the archive.

 Installing L&TT for HP-UX, Tru64, and 
Linux
To install L&TT for HP-UX, Tru64, or Linux:

1. Log on as root.

2. Navigate to the temporary directory:

cd /tmp

3. Download or copy the L&TT tar file, hp_ltt<xx>.tar (where <xx> 
is the version number) to this directory. If you are copying the file 
from a different location, enter the following (substitute the 
directory in which the file currently resides for <directory name>):

cp /<directory name>/hp_ltt<xx>.tar /tmp

4. Untar the L&TT tar file:

tar -xvf hp_ltt<xx>.ta

5. Run the install script in the /tmp

./install_hpltt<xx>

6. After the software is successfully
commands to remove the /tmp/

cd /tmp

rm -rf ltt

rm -rf install_hpltt

 Starting L&TT
To start L&TT:

■ For HP-UX, Tru64, and Linux:

Log on as root and execute the fo

cd /opt/ltt

./hp_ltt

■ For Novell NetWare

From the server console, execute

hp_ltt\hp_ltt

When the CSI version of L&TT is sta
displayed that offers basic information
Press any key to bypass this screen an
scans the system for connected device
Main screen is displayed, as shown in

Figure 1:  CSI Main screen

 Navigating the S
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hierarchical format. Each “level” of sc
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lower level in the hierarchy. To move 
up command. To exit L&TT, use the e
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without typing any other text) display
screen contains a list of valid comman
original screen from which you access
Figure 2 shows the Command Help s
screen.
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Using the Drive Performance Test
To start the CSI version of the Drive Performance test:

1. From the Main screen, enter the following command to display the 
Device Performance Tool screen:

devperf

The Device Performance Tool screen displays several test options 
with their default settings.

2. If necessary, change the settings for one or more options. To change 
the settings, enter the number that corresponds with the option that 
you want to change. Enter the new value at the prompt. The five 
available options for this test are:

■ Blocksize—specify the blocksize, in bytes, to be written to the 
tape. Typical values are 32768 (32KB), 65536 (64KB). The 
default is 65536.

■ Repetitions—specify how many write/read operations to 
perform. The default is 4096.

■ Readback—specify whether to enable the readback test after 
writing data to the device. This option measures read 
performance in addition to write performance in MB/sec. This 
option is disabled by default.

■ Count—specify how many blocks to write to the tape device 
per write operation. The default is 16.

■ Pattern—specify the data pattern to be written to tape. Enter 2 
for 2:1 compression ratio or 3 for 3.1:1 compression ratio. The 
default is 2.

3. Use the start command to start the test.

Viewing Performance Test Results
To view detailed test results, enter the review command. Test results 
are displayed in a hierarchical format. 

Use the detail command without any arguments to view the current 
detail level of the report. Use the detail command with a numeric 
argument to set the detail level. The available detail level arguments are:

■ 1 — highlights only

■ 2 — normal

■ 3 — more details

■ 4 — everything

■ 5 — factory only (requires a factory password. To enter a password, 
use the options command.)

If necessary, use Ctrl+U and Ctrl+D to scroll up and down through the 
results. You can also use the find and page commands to quickly 
locate information in the report.
■ OBDR capability (if present)

If a data cartridge was inserted in the drive when the Device 
Information screen was displayed, information regarding cartridge type, 
capacity, and write-protect status is shown. 

To see a list of compatible media that can be used with this device, use 
the inventory command.

Library and Autoloader Products
Figure 4 shows the Device Information screen for a library.

Figure 4:  Device Information screen showing a library

Note:  Selecting individual drives within a library from the device list displays 
the drive as though it were a standalone product. Embedded drives are best 
diagnosed by selecting the library they belong to, and then selecting the 
specific drive within each tool window.
From the Device Information screen for a library device, use the 
inventory command to display the slot inventory of the library. The 
inventory command shows which slots and drives currently have 
cartridges loaded, and the cartridge barcode if available and applicable.

 Support Ticket Generation
A major feature of HP StorageWorks Library and Tape Tools is the 
ability to generate a support ticket. In the event of a hardware problem, a 
support ticket can provide vital information to help in diagnosing and 
resolving the problem. 

Generating and Viewing a Support Ticket
To generate and view a support ticket in the CSI environment:

1. From the Main screen, select the device that you want to create a 
support ticket for. The Device Information screen is displayed.

2. Enter the support command to access the Support screen.

3. From the Support screen, do one of the following:

■ Enter the view command to view the support ticket.

■ Enter the save <filename> command to save the support 
ticket with the specified filename. The support ticket can be 
viewed later using the load command from the Main screen.

When viewing the support ticket, use Ctrl+U and Ctrl +D to scroll up 
and down through the results. You can also use the find and page 
commands to quickly locate information. For more information about 
the information reported on a support ticket, refer to the user guide or 
online help.

 Firmware Management
The Firmware Management functionality of L&TT provides a 
convenient way to easily upgrade the firmware of connected devices. 
Library firmware and firmware of drives within the libraries can be 
upgraded as well. In many cases, multiple drives within the library can 
be updated simultaneously to save time.

L&TT uses special firmware files that associate the firmware with a 
particular product. This feature prevents the user from downloading the 
wrong image and ensures that the downloaded firmware is the same or a 
newer revision than the current device firmware.

Acquiring Firmware Files
L&TT firmware files are stored in the firmware directory, which is a 
subdirectory of the HP Library & Tape Tools installation 
directory. Before upgrading any firmware, you must acquire the 
firmware image file or files and copy them to the firmware directory.

To download the latest firmware files:

1. Go to www.hp.com/support, choose the product family, then click 
software updates and drivers. The latest firmware file is available 
in L&TT format. For some products (such as standalone drives), 
firmware is available as a single file. For other products (such as 
tape libraries), the firmware is available in a self-extracting bundle 
that includes library and drive firmware. 

2. Download the file or files to the firmware directory.

3. If the downloaded files were self-extracting bundles, extract the 
contents to the firmware directory.

Uploading Firmware to Devices
To upload firmware to one or more devices:

1. From the Main screen, type the number corresponding to the device 
you want to update and press Enter to display the Device 
Information screen.

2. From the Device Information screen, enter the firmware 
command to display the Firmware Update screen. Devices that are 
available for update are listed on this screen.

3. Type the corresponding number of the device that you want to 
update and press Enter to mark the device “selected.” If there are 
multiple devices, repeat this step for each device that you want to 
update.

4. When you have selected all of the devices that you want to update, 
enter the start command to begin the update process.

Caution:  Make sure that no other programs attempt to access the 
device while the firmware is being updated. Do not interrupt the 
firmware update. If the firmware update is interrupted, the device 
may not operate and require physical repair.

L&TT creates a log of all firmware update activity. To view this log, 
enter the review command from the Firmware Update screen.

 Tests
L&TT provides numerous tests for analyzing storage hardware. These 
tests are grouped into two categories: diagnostic tests and performance 
tests. Several of the diagnostic tests are SCSI script-based. A SCSI script 
is a sequence of SCSI commands sent to a device, usually for the 
purpose of testing the device’s functionality. SCSI scripts can also be 
used to perform non-diagnostic utility functions, such as rewinding a 
tape, recalibrating a tape head, or “exercising” a tape-moving robot arm. 
A main advantage of SCSI script-based tests is that they can be updated 
with new functionality and new tests can be added. For more information 
about available tests, refer to the user guide or online help.

Running the Diagnostic Tests
To select and run a test manually:

1. On the Main screen, enter the number corresponding to the device 
that you want to test. The Device Information screen is displayed.

2. On the Device Information screen, enter the test command. The 
Test screen is displayed. The Test screen displays the currently 
selected test, and lists the available devices to be tested.

3. To select a different test, enter the picktest command. On the 
Selector screen, enter the number of the test you want to perform. 
The Test screen is redisplayed and the currently selected test is 
updated.

4. To select or deselect devices to be tested, enter the corresponding 
device number to toggle the selected status of the device. To 
deselect all devices, enter the clear command.

5. Enter the start command to start the test.

6. When the test is complete a dialo
preliminary results of the test. Pr
screen.
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Using the System Performanc
To start the System Performance Pre-T

1. From the Main screen, enter the 
System Performance screen:

sysperf

2. Enter one of the following comm
you want to run):

■ backup—runs the Backup

■ restore—runs the Restor

3. If necessary, change the settings f
the settings, enter the number tha
you want to change. Enter the ne
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■ Blocksize—specify the bloc
values are 32768 (32KB), 6
65536.

■ Path—specify the path to th

The following options are availab
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— 1 Fixed byte

— 2 Incrementing byte

— 3 Random data

— 4 1.6:1 compressibl
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— 7 4.3:1 compressibl

4. Use the start command to star
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